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1. Introduction 
Congratulations on choosing the ALVA 640 Comfort. The ALVA 640 Comfort merges 
classic Braille display access with advanced functionality. The high quality and reliability 
of the ALVA 640 Comfort gives you optimal flexibility and productivity in an ultra 
compact design. 
 
Each ALVA 640 Comfort features future proof hardware standards as wireless 
Bluetooth® connection and USB ports. The ergonomic design with its high quality 
Braille cells and optimal navigation possibilities allows you to be in full control of your 
computer, tablet or smart phone. Used in combination with screen reading software 
the ALVA 640 Comfort can be installed for a wide range of operating systems to 
provide a tactile and audible user interface. 
 
The ALVA 640 Comfort offers an enhanced ergonomic design that extends the 
navigation and operation possibilities of the screen reading software. The ergonomics 
are designed for optimal efficiency when working with a computer, tablet or 
Smartphone.  
 
The ALVA 640 Comfort was designed to adhere to the Open Standard philosophy 
using mainstream technology. This enables compatibility with most screen reading 
software and operating systems. The available and supported functionality of the 
ALVA 640 Comfort depends on the Braille display options of your screen reader, your 
mainstream computing hardware and operating system. 
Contact your distributor or Optelec for updated information about screen readers that 
fully support the device. 
 
If you have any questions or suggestions concerning the use of this Braille display, 
please contact your distributor or Optelec’s head office using the contact information at 
the last page of this manual. Your feedback is highly appreciated. We hope you enjoy 
working with your ALVA 640 Comfort. 
 

1.1. About this manual 
This manual will familiarize you with the features and basic operation of your ALVA 
640 Comfort. Please read this manual carefully before using your device. Please note 
that this manual is about the ALVA 640 Comfort and does not contain information 
about screen readers, screen reader commands, screen reader installation 
procedures, screen reader Braille display selection or screen reader key 
assignments. Refer to your screen reader documentation  to find out more on these 
topics.    
 

1.2. ALVA 640 Comfort package contents 
The ALVA 640 Comfort package contains the following: 

– The ALVA 640 Comfort  
– A pouch  
– USB cable 
– The ALVA 640 Comfort driver software for Windows 7 and higher and 

documentation on CD-ROM 
If any of these items are missing from your package, please contact your distributor. 
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2. Getting to know your ALVA 640 Comfort 
The ALVA 640 Comfort consists of a 40 cell Braille line with advanced navigation 
possibilities and a Braille keyboard. This chapter will give a detailed overview of the 
lay-out of the ALVA 640 Comfort. 
 

2.1. The ALVA 640 Comfort lay-out 
 
The ALVA 640 Comfort is placed correctly in front of you when the Braille input keys 
are located at the back of the flat surface and the thumb keys are facing towards you. 
 
The ALVA 640 Comfort contains: 

1. 40-cell Braille display 
2. Two  eTouch keys (left of the Braille line) for panning left and right or other 

screen reading functions 

3. Two eTouch keys (right of the Braille line) for panning left and right or other 
screen reading functions 

4. Five thumb keys for panning, left, right, up and down and returning to the 
cursor position 

5. 40 Cursor Routing Keys 

6. Mini USB connector 

7. On/off switch 
8. Feature connector 

9. The Ctrl key 

10. An eight key Braille keyboard (From left to right Braille keys 7, 3, 2, 1, 4, 5, 
6, 8) 

11. Windows key (to open the Windows Start Menu) 

12. Enter key 
13. Alt key 

14. Space bar                                     10 

  
9   11  12                        13    

 
                                                                                                   7 

 
           2                         3 
 

 
  8 6 
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2.1.1. Surface and front panel lay-out 
The ALVA 640 Comfort is designed with a row of 40 Braille cells. In front of the Braille 
cells one row of small buttons can be found, known as Cursor Routing Keys. Each 
Braille cell has a corresponding Cursor Routing Key that can be used for multiple 
functions. On the left and right side of the Braille line you will find two groups of two 
keys. These so-called eTouch keys can be used for Braille panning left and right as 
well as various other screen reader functions. 
 

2.1.2. Right side lay-out 
The power switch is located at the right side of the Braille display. The Braille display 
is switched on when the rectangular push button is pressed. Switching the Braille 
display on will generate an audio signal. 
 

2.1.3. Left side lay-out 
The left side of the Braille display contains two connectors. From front to back: mini 
USB connector and a feature connector. The feature connector has no function with 
the release of this manual.   
 

2.1.4. Front panel keys, eTouch navigation buttons and cursor routing keys 
The names of the ALVA 640 Comfort keys listed in this section will be used in all 
documentation, including your screen reader documentation. This section describes 
the name of the key(s) and its main function, which is supported by the screen 
reader. The exact functionality is defined by the screen reader. Please refer to your 
screen reader documentation for detailed functionality of the ALVA 640 Comfort. 
 
eTouch keys 
The two keys on each side of the Braille line are called the eTouch keys. They are 
used for panning left and right as well as various other Braille functions. 
eTouch 1 Top left key marked with two vertical lines 
eTouch 2  Bottom left key marked with one horizontal line 
eTouch 3 Top right key marked with two vertical lines 
eTouch 4 Bottom right key marked with one horizontal line 
  
Cursor Routing Keys  
The cursor routing keys correspond to the particular Braille cell immediately above 
each button. Typically, they are used for routing the cursor or caret to the 
corresponding Braille cell, generating a left or right mouse click at that point, or for 
obtaining additional information about the contents of the Braille cell. 
 
Thumb Keys 
At the front of the Braille display five front panel keys are placed, the so called thumb 
keys. Four bigger keys are symmetrically aligned along the front of the ALVA 640 
Comfort. One smaller button is located in the middle of the front. Pressing one of the 
four bigger thumb keys will navigate left, right, up or down. By pressing the middle 
key you will return to the cursor position 
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2.1.5. ALVA 640 Comfort Braille keyboard lay-out 
The ALVA 640 Comfort  is designed with an eight-key Braille keyboard that is located 
directly behind the 40 cell Braille line. The Braille keyboard consists of eight Braille 
keys, a space bar, a Ctrl key, a Windows key, an Enter key and an Alt key. The 
space bar is the long key that is located at the centre of the Braille keyboard. The 
eight rectangular keys located at the left and right of the space bar are the Braille 
input keys. The four square keys are the Ctrl key, Windows key, Enter key and Alt 
key. From left to right the keys are labeled as Ctrl key, Braille key 7, Braille key 3, 
Braille key 2, Braille key 1, Windows key, Enter key, Braille key 4, Braille key 5,  
Braille key 6, Braille key 8 and the Alt key. 
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3. Installation 
In this section, a general description of the installation procedure is described for the 
JAWS, Window-Eyes and Dolphin Supernova screen readers for Windows 7 and 
higher and the  setup and Bluetooth® installation.  
 
The ALVA 640 Comfort is compatible with most modern operating systems, including 
Windows 7, Windows 8, Linux, Apple OS X, Apple iOS, Google Chrome OS and 
Android. Please refer to the screen reader documentation for instructions on how to 
setup and configure the Braille display for your screen reader of choice and operating 
system. 
 

3.1. Setting up the ALVA 640 Comfort  

3.1.1. Setting up the USB connection  
The ALVA 640 Comfort does not need any special USB drivers. Windows 7  (or 
higher and most other operating systems) will automatically detect the ALVA 640 
Comfort and install the necessary USB drivers.   

1. Attach the USB cable to the ALVA 640 Comfort and computer.  
2. A 8GB removable drive will appear on the screen. This drive contains the 

ALVA 640 Comfort screen reader drivers for JAWS, Window-Eyes and 
Dolphin Supernova. 

3. Switch on the ALVA 640 Comfort. Windows will automatically install the 
necessary drivers. This process will approximately take 1 minute. Please 
do not turn off the ALVA or cancel the installation during this process. 
Generally this does not require any further user input. When the connection 
is established the ALVA 640 Comfort will issue an audible signal and 
displays the message “USB connected”. 

 

3.2. Installing ALVA 640 Comfort screen reader drivers 
Drivers for the majority of the screen readers are included in the products 
themselves. Therefore, you do not need to install the screen reader drivers from the 
ALVA 6-series CD-ROM or removable drive within the ALVA. Please refer to your 
screen reader documentation for more information on the setup of, and selection of  a 
ALVA 640 Comfort and to select  and configure the unit in your screen reader.   
 
Only if the drivers on the CD-Rom are newer than the drivers included with the 
screen reader,  we recommend to install the screen reader drivers from the CD-ROM 
or ALVA internal removable drive: 

1. Insert the ALVA 640 Comfort software CD-ROM that came with the package 
in your computer’s disk drive. 

2. The program will automatically run if the autostart feature of your CD-ROM 
drive is enabled.  

a. If the autostart feature is not enabled, press the Windows key and 
type d:\setup.exe (assuming d: is the letter assigned to your CD-ROM 
drive) and press Enter.  
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b. Or, locate the ALVA folder on the ALVA 640 Comfort removable drive 
and run the “Setup.exe”. 

3. Select “Install screen reader drivers” 

4. The setup program will guide you through the installation. 

5. The setup program will automatically search your system for installations of 
JAWS, Window-Eyes and Dolphin screen readers and will install all 
necessary drivers, manuals and the ALVA BC6 Bluetooth® pairing utility.  

 

3.3. Bluetooth® connection 
 
To create the Bluetooth® connection with your ALVA, the device will need to be 
paired with the PC using the ALVA Bluetooth Utility included with the ALVA screen 
reader drivers.  
 
Important: 
Please use the ALVA Bluetooth Utility to establish the Bluetooth connection. Do not 
use the standard Windows Bluetooth pairing  control panel applet. The ALVA 
Bluetooth Utility will register the ALVA with the screenreader.  
 
Pairing the ALVA 640 Comfort using the ALVA BC6 Bluetooth®Utility 
 

1. Launch the ALVA BC6 Bluetooth® Utility located on your desktop or by 
going to Start, All Programs, ALVA BC6, ALVA BC6 Bluetooth® Utility; 

2. Press the Search button.  

3. Select the “ALVA BC640 CF” from the list by checking the checkbox; 

4. Click on “OK” if you did not changed the default PIN code “0000”.  
Otherwise, please enter your PIN code and click on “OK”.  

 
Connecting the Bluetooth ALVA 640 Comfort Braille keyboard: 

1. In the ALVA Bluetooth® Utility, select the ALVA BC640 CF  you just paired 
from the list and right click or press shift-F10; 

2. Select “Connect keyboard” from the context menu.  
3. A new window will open. In this window, select your ALVA (Other device) 

and right click or press shift-F10; 

4. In the context menu, select “Properties”; 
5. On the “Services” tab, check the checkbox to enable the keyboard service.  

 

Note: This step can be skipped when using JAWS or Dolphin Supernova. JAWS and 
Supernova support direct Braille input and do not require the Braille keyboard driver 
to be installed. 

Unpairing the ALVA 640 Comfort 
1. In the ALVA Bluetooth® Utility, select the ALVA BC640 CF from the list and 

right click or press shift-F10; 
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2. Select “Unpair” from the context menu and press enter. 
 
Please note: 

A.  You will have to restart  your screen reader to establish the Bluetooth® 
connection. 

B. Most screen readers use the first found ALVA. Therefore, make sure that the 
ALVA you would like to use is at the top of the list. Use the “Up” button in the 
ALVA Bluetooth® Utility to move an ALVA up the list.   

C. Unchecking the checkbox in the list of paired ALVA’s in the ALVA Bluetooth 
Utility will not unpair the ALVA. By unchecking the checkbox the screen reader 
will no longer use this particular ALVA and wil remove it from the list of 
available ALVA’s for the screen reader.   

D. If there are multipe Bluetooth® stacks installed on your system, make sure you 
select the Bluetooth® stack you would like to use with your ALVA in the ALVA 
Bluetooth® Utility before proceeding with pairing the unit.  
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4. The ALVA 640 Comfort menu 
 
This chapter describes the menus of the ALVA 640 Comfort. Standard there is one 
so-called Local Menu on the ALVA 640 Comfort.  
 
When the ALVA 640 Comfort is switched on, the following message is displayed: 

“ALVA 640 Comfort” followed by the date and time. 

This message will automatically disappear when the screen reader is loaded and a 
successful connection with the ALVA 640 Comfort is established.  
 

4.1. Local Menu 

4.1.1. Activating the Local Menu 
To enter  the local menu press space + M (Braille key 1, 3 and 4) and click with the 
cursor routing keys on “Settings”. 
 
To exit the Local Menu press eTouch key 1. eTouch key 1 is the top key marked with 
the 2 vertical lines, located left of the Braille line.    
 
Note: Depending on the used screen reader, you may need to close your screen 
reader first in order to access the local menu. 

4.1.2. Changing settings in the Local Menu 
The Local Menu allows you to configure the ALVA 640 Comfort or review information 
about the current status of the ALVA 640 Comfort.  
 
To navigate in the menu use the following keys: 
Local menu     Key Combination 
Next menu item    Tumbkey  4 
Previous menu item    Thumbkey 2  
Select menu item    Thumbkey 3  
Next field in menu item   Thumbkey 5  
Previous field in menu item  Thumbkey 1  
Change value in menu field item  Thumbkey 2 or 4  
Confirm and leave field   Thumbkey 3  
Exit menu without saving changes eTouch key 1 
 
To indicate that a menu item is activated, it will be underlined with dot 7 and 8. 
 
The Local menu has the following items: 

Battery:  45%, charging 

 Battery presents the status of the battery and informs you if the battery is charging. 
In case the USB connection is used, the ALVA 640 Comfort will charge automatically. 
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 Notes 

Notes. This menu item activates Notes. The shortcut key to activate Notes is space + 
N. Please note that depending on the used screen reader, you may need to close 
your screen reader first in order to be able to open Notes. 
 
 

Date/Time: 01/01/2014  01:00:00 

Date and time. This menu item shows the current date and time. To set the date and 
time and to change the date and time format, please refer to the set date, set time 
and date and time format menu options.  
 

Bluetooth®status: connected 

Bluetooth® status displays if the ALVA 640 Comfort Bluetooth® is connected or 
disconnected. 
 

Set Bluetooth®pairable 

Set Bluetooth® pairable. Activating this menu item will disconnect the current 
Bluetooth® connection and make the ALVA 640 Comfort visible to other Bluetooth® 
devices. Alternatively, switching the ALVA 640 Comfort off and on will disconnect the 
current Bluetooth® connection and switches the Bluetooth® module into the pairable 
state too. 
  

Bluetooth: on 

Bluetooth® on / off. The ALVA 640 Comfort Bluetooth® module can be switched on 
or off using this menu item.  
 

Bluetooth®pin: 0000 

 Bluetooth® PIN. The ALVA 640 Comfort is protected by a Personal Identification 
Number (PIN) to prevent other people from setting up a wireless connection with your 
Braille display. This setting allows you to enter your own PIN code. By default the PIN 
code is set to 0000. This number is required when setting up a wireless connection 
with your PC or other Bluetooth® device. Use this menu item to change the 
Bluetooth® PIN.  
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Bluetooth®name: ALVA BC640 CF 

Bluetooth® Name. Specify the Bluetooth® name for the ALVA 640 Comfort. This 
allows you to uniquely identify the ALVA 640 Comfort in case you are setting up a 
wireless Bluetooth® connection with your PC or other Bluetooth® device. By default 
the Bluetooth® name is ALVA BC640 CF. To be able to use your ALVA with Apple  
and Android devices, please do not change the default name. Apple and Android 
require the Bluetooth® name to start with ALVA BC640. 

Sleep: 30 

 Sleep. By default the sleep time function is set to 30 minutes. Set a time of 5, 10, 15 
or 30 minutes, indicating the time after which the Braille display puts itself into sleep 
mode if there is no activity. To disable the sleep function, select never. Consequently, 
the ALVA 640 Comfort consumes virtually no energy when the Braille display is in 
sleep mode.  

Braille configuration 

 Braille configuration. The Braille configuration submenu contains three menu items: 
keyboard layout, Braille table and contracted (Grade 2) table. These three items are 
being used to translate the Braille input on the 8-key Braille keyboard into text for the 
internal Notes and screen readers or screen reader drivers that do not support Braille 
input.  

 
 Apple Voice Over, Android BrailleBack, JAWS and Dolphin Supernova are examples 

of screen readers that do support Braille input. Therefore, these screen readers are 
not  influenced by these settings.  

 
 It is important to select the same keyboard layout on the ALVA 640 Comfort as in 

Windows. Your Windows keyboard layout can be found in the Windows Control 
Panel / Change keyboards and other input methods. When a keyboard layout is 
selected, the ALVA 640 Comfort will attempt to match the Braille table and contracted 
table if present. If there is no matching Braille table present, no changes will be 
made. Alternatively, you can manually select a different Braille table or Contracted 
table. The default Braille table is the NABCC (North American Braille Character 
Code) and the US English contracted table. The selected Braille table is used in the 
Local Menu.  

  
 Please note that screen readers have their own Braille tables. Therefore, the Braille 

that is being displayed on the Braille display cannot be controlled by the ALVA 640 
Comfort. Selecting a different Braille table for displaying Braille should be done in the 
screen reader itself.  

   
 To enable or disable the contracted (or Grade 2) Braille input, press Space + B1245 

(Braille keys 1, 2, 4, 5). The ALVA 640 Comfort will generate a series of beeps to 
indicate that the contracted Braille is turned on or off. Space + B234 will enable or 
disable the special character set for languages that require multi-lingual input. When 
the Arabic Braille input is selected, this key combination will toggle between English 
and Arabic input.  
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 Note: JAWS and Dolphin Supernova use their build-in Braille translation and 

ignore the ALVA 640 Comfort Braille translation. Therefore, the space + B1245 
command is ignored when using one of these screen readers. 

 

Dot pressure: 5 

Dot pressure. Select the Braille reading comfort by setting the dot pressure. If you 
prefer hard and stiff Braille dots set the value to 5. If you prefer soft and weak Braille 
dots, set the value to 1. The default setting is 5. 
 

Number status cells: 0 

Number status cells. By default the number of status cells is 0. To enable status 
cells, select a value of 1 to 20 status cells. If the status cells are set to 0, the status 
cells will be disabled and all 40 Braille cells are used for displaying text and data. 
Status cells provide useful information about the text on the screen, Windows 
controls and screen reader mode. 
 
Please note that some screen readers, such as JAWS, ignore this setting. To set the 
number of status cells in JAWS, plese refer to the JAWS help documentation.   

Status cells: Left 

Status cells. The default position of the status cells is on the left. Select the position 
of the status cells either on the left or right side on the Braille display.  
 
Please note that some screenreaders, such as JAWS, ignore this setting. To set the 
number of status cells in JAWS, plese refer to the JAWS help documentation.   

Split point configuration menu 

When split point is enabled, the Braille display will be divided into two segments. 
This enables you to read and interact with two devices simultaneously. For example, 
the Bluetooth® screen reader output of a mobile phone can be displayed on the first 
segment of the Braille display while the second segment can be used to read the PC 
screen reader output via the USB connection. The cell between the two segments will 
have all 8 dots raised to indicate where the first segment ends and the second 
segment starts. By default the first segment will display the information send via the 
Bluetooth® connection. The second segment will display the information send via the 
USB connection. To be able to use the split point feature, please make sure your 
screen reader supports this function. To find out if your screen reader supports the 
ALVA split point functionality, please refer to your screen reader documentation.  
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Split point configuration menu : Split point active: off 

Split point active. The first item in the Split point Configuration menu is the option to 
enable or disable the split point feature.  

Split point configuration menu: Split point: 5 

Split point. Adjust the number of cells used for the split point function by selecting 
the number of cells.  

Split point configuration menu: Display layout: BT-USB 

Display layout. This option selects which connection is linked to a Braille display 
segment. By default the Bluetooth® connection is linked to the first segment and the 
USB connection to the second segment. The display layout can be changed using 
the quick menu Space+M. In this menu select the "Preferred Interface" and toggle 
the option by activating it with the cursor routing.   
 

Split point configuration menu: Keys to: left segment  

Keys to. When selecting the keys to the left or right segment, the ALVA 640 Comfort 
keys will be directed to the selected segment and connection. The display layout can 
be changed using the quick menu Space+M. In this menu select the "Preferred 
Interface" and toggle the option by activating it with the cursor routing. 
 

Repeat keys: on 

Repeat keys. The repeat function of the thumb keys can be enabled or disabled. 
When holding down a thumb key with the repeat function switched on, the thumb 
keys will start repeating after half a second. This enables you to quickly scroll the 
display by keeping the thumb key pressed. 

  

2nd cursor routing row: on 

2nd cursor routing row. The ALVA 640 Comfort is equipped with one row of cursor 
routing keys. However, by keeping the cursor routing key pressed the ALVA 640 
Comfort is able to emulate a second row of cursor routing keys. This will give you the 
possibility to perform a left and a right mouse click with one row of cursor routing 
keys. When enabled, the ALVA 640 Comfort will differentiate between a short and a 
long cursor routing key press. A short press will be treated as a press of a key of the 
first row of cursor routing keys, while a long press will be seen as a press of a key of 
the second row of cursor routing keys. The length of a “long press” can be set by 
adjusting the delay time. The default time is half a second. The assignment of the first 
and second row of cursor key actions depends on the used screen reader. Refer to 
your screen reader documentation for the assignment of the first and second cursor 
routing key actions.   
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2nd cursor routing delay: 500 ms 

2nd cursor routing delay. The length of the delay before the second cursor routing 
key is activated can be set by adjusting the delay time. By default the delay is set to 
500 ms or half a second. 
 

Sounds: off 

Sounds can be switched on or off. When switched on, a short beep is being 
generated on each key press. If you prefer no sounds to be generated, select “off”. 
For each group of keys the beeps can be switched on or off individually.  

Cursor routing sound: on 

Cursor routing sound can be switched on or off. When switched on, a short beep is 
generated on each cursor routing key press. If you prefer no sounds to be generated 
when a cursor routing key is pressed, select off.  

eTouch key sound: on 

eTouch key sound can be switched on or off. When switched on, a short beep is 
generated on each eTouch key press. If you prefer no sounds to be generated when 
an eTouch key is pressed, select off.  

Thumb key sound: on 

Thumb key sound can be switched on or off. When switched on, a short beep is 
generated on each thumb key press. If you prefer no sounds to be generated when a 
thumb key is pressed, select off.  
 

Set time: 01:01:00 

Set time. This setting allows you to adjust the time of the internal clock of the ALVA.  

Set date: 01:01:2014 

Set date. This setting allows you to adjust the date.  

Date format: dd-mm-yyyy 

Date format. This setting allows you to set the date format. By default this is set to 
day / month / year. The date can be displayed in the formats dd-mm-yyyy, yyyy-mm-
dd and mm-dd-yyyy.  
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Date separator: / 

Date separator. This setting allows you to set the date separator. By default the “/” 
symbol is used. The date separator can be changed in a  “/”, “:”, “.” or “-“. 

Time format: 24 hours 

Time format. This setting allows you to set the time format. The default is the 24 
hour format. The time can be displayed in either the 24 hours or 12 hours format.  

Time separator: : 

Time separator. This setting allows you to set the time separator. The default is the 
“:” symbol. The time separator can be changed in  “.” or “:“. 

Language: English  

 Language. Select the language for the Local Menu. 

Prefered interface: Bluetooth® 

Select the prefered interface; Bluetooth® or USB. If the ALVA 640 Comfort is 
connected to two mainstream devices using its Bluetooth® and USB connection, the 
device will only “communicate” with the prefered interface. By default the prefered 
interface is Bluetooth®. The USB connection will be ignored.  
  

ALVA System drive: on  

ALVA System drive. When the ALVA System drive is on, the internal drive is visible 
and accessible by Windows. When turned off, the drive is no longer accessible by 
Windows resulting in the drive not popping up when switching on the ALVA 640 
Comfort. 

BT MAC: xxxx:xx:xxxxxx 

 BT MAC refers to the ALVA 640 Comfort Bluetooth® MAC address. A Bluetooth® 
MAC address uniquely identifies a Bluetooth® device.   

Firmware: #.#.# BT: #.##.#   

Firmware version shows the version of the built in ALVA 640 Comfort software and 
the software version for the Bluetooth® module.  

Hardware: 98 

 Hardware version shows the version of the ALVA 640 Comfort hardware revision. 
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Restore factory settings 

Restore factory settings allows you to restore the factory settings. If you select this 
option the ALVA 640 Comfort factory defaults will be restored. Alternatively, the 
ALVA 640 Comfort factory defaults can be restored by deleting the SETTINGS.A6 file 
from the internal ALVA_BC6 drive. To delete the SETTINGS.A6 file: 

- Connect your ALVA 640 Comfort to the USB port of your PC using the supplied 
USB cable 
- The ALVA_BC6 driver will automatically appear 
- Locate and open the system folder 
- Locate the SETTINGS.A6 file 
- Delete the file  

 
To format the internal drive and restore all settings, press thumb key 1 and 5 while 
switching on the unit. Please be aware that this will delete all Notes files as well as 
the contracted Braille tables. After formatting the internal drive, the contracted Braille 
tables will need to be installed again. Without these tables, contracted Braille will be 
disabled. To install the Braille tables again, run the ALVA setup. 
 
Note: The system folder is a hidden folder. To see hidden folders, you have to enable 
“show hidden files and folders” in Windows Explorer. 

Test mode 

Test mode. Use the test submenu if you have the impression that certain keys or 
Braille cells are not responding properly. The ALVA 640 Comfort has two built-in 
tests: a Braille cell test and a key test. When activating the key test, pressing a 
particular key provides a unique dot pattern on the array of Braille cells. The Braille 
cell test will cycle all dots continuously.  

4.2. The Bluetooth® Menu 
Use the quick menu Space+M to access the Bluetooth® menu. Open the Bluetooth® 
menu by activating it with the cursor routing. To exit the Bluetooth® Menu, press 
eTouch key 1.  
 

BT: Braille keyboard  

Bluetooth® Menu. The Bluetooth® Menu shows the status of the various 
Bluetooth® connections. If a connection is activated, dot 7 and 8 will be raised to 
indicate the connected state. Clicking on a connection with the cursor routing keys 
will connect or disconnect the particular Bluetooth® connection.  
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5. Power Sources 
 
There are two ways to power the ALVA 640 Comfort: 
 
 Using the USB power; 
 Using the internal battery. 

 
In the subsequent sections, you will find more information about each power option. 
 

5.1. USB power 
If you connect your ALVA 640 Comfort directly to a PC using the USB connection, 
the PC will provide power to the Braille display through the USB cable. The USB 
connection provides sufficient power to charge the unit’s internal battery and to 
operate the ALVA 640 Comfort. 
 

5.2. Internal battery  
The ALVA 640 Comfort runs on an internal battery if no USB connection is used. The 
ALVA 640 Comfort will approximately run up to 12 hours on a fully charged battery.  
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6. Using the Braille keyboard 
 
This chapter provides an overview of the Braille key combinations that emulate 
keyboard function keys. There are two types of function keys; chord commands to 
emulate keyboard function keys and prefix chord commands to emulate function key 
combinations. 
 

6.1. Chord commands  
 
Chord commands are Braille key commands that are combined with the space bar. 
These chord commands are used to emulate keyboard function keys such as Home, 
End, Backspace, Delete and Escape. Please note that these commands can only be 
used with screen readers that do not support direct Braille input. JAWS, Dolphin 
Supernova, Voice Over and BrailleBack have their own Braille commands for these 
functions. Please refer to the screen reader documentation for the list of Braille 
commands for these functions. 
 
Overview of chord commands: 
Chord command Keyboard key 
Backspace Space + b12 
Escape Space + b15 
Delete Space + b45 
Page up Space + b13 
Page down Space + b46 
Home Space + b123 
End Space + b456 
Tab Space + b56 
Shift-Tab Space + b23 
Shift-Space Space + b7 
Arrow up Space + b1 
Arrow down Space + b4 
Arrow left Space + b3 
Arrow right Space + b6 
Word left  Space + b2 
Word right Space + b5 
Shift-Arrow up Space + b17 
Shift-arrow down Space + b47 
Shift-Arrow left Space + b37 
Shift-Arrow right Space + b67 
Shift-Page down Space + b467 
Shift-Page up Space + b137 
Shift-Home  Space + b1237 
Shift-End  Space + b4567 
Shift-Delete Space + b457 
Shift-Escape Space + b157 
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6.2    Prefix chord commands  
 
There are four prefix chord commands to emulate the function keys F1 to F12 (Space 
+ b124 for activating F, followed by the number 1 to 12), Insert (Space + b24), Caps 
Lock (Space + b14) and Num Lock (Space + b136) combinations.  
 
To press one of the function keys F1 to F12, press Space + b124 (Space + F) 
followed by a character. The function key number is represented by the characters 
“a” to “I” while the character “a” represents F1 and “I” represents F12. To press F1 
using the Braille keyboard, first type space + b124 followed by the character “a” 
(Braille key 1). Press the Space + b124 combination once again to exit this function.  
 
Similarly, the Insert, Caps Lock and Num Lock can be typed by pressing Space + 
b24 for Insert, Space + b14 for Caps Lock and Space + b136 for Num Lock. To type 
an Insert + J command, press Space + b24 followed by a “j” (Braille keys 2, 4, 5). 
Typing the Insert, Num Lock or Caps Lock command twice will switch the status of 
this command on or off, depending on its current status.  
 

6.3    Contracted Braille on/off 
 
The chord + g command or Space + b1245 will turn contracted Braille (Grade 2) on 
or off. The contracted Braille table can be set in the Local Menu/ Braille configuration/ 
Contracted Braille table.  
 
Before you can use contracted Braille input make sure the contracted Braille tables 
are installed. To install the contracted Braille tables: 
1. Connect your ALVA 640 Comfort to the pc via USB and switch it on; 
2. Start the ALVA 640 Comfort installation by locating the Setup on the CD or on the 
internal ALVA BC6 USB drive; 
3. Select the button "Install contracted Braille Tables"  and wait until the setup is 
completed. 
 
Note: 
JAWS, Dolphin Supernova, Voice Over and BrailleBack use their own Braille 
contraction.  

6.4.     Special characters on/off 
Space + b234 toggles special character input on / off. This option is being used for 
Arabic Braille input. Toggling this special characters on / off makes it possible to 
enter Arabic Braille and insert an English word or phrase without having to switch to 
another Braille table.  
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7. Notes 
 
The Notes application enables you to write and save notes on the internal memory of 
the ALVA 640 Comfort. Notes contains a few elementary text adding and editing 
functions such as copy, cut, paste and a block function. 
 
No PC connection is required to use Notes. The ALVA 640 Comfort Braille keyboard 
has to be used to enter Notes. It is not possible to enter text in Notes via the PC 
keyboard. 
 
Text entered in Notes will be saved in text format. To correctly translate the Braille 
input to text format make sure the correct Braille table is selected in the Local Menu, 
Braille Configuration. If you enter text in contracted Braille, the file will be saved in 
contracted Braille. To translate the file to text format, save the file using the menu 
option "Contracted to text" under the Notes Braille menu.  
 
Notes is capable of reading text files created in Windows Notepad or Word that are 
saved as a "txt file". Files can be copied from and to the ALVA 640 Comfort System 
drive with the Windows Explorer. Make sure that the files are copied to the Notes 
folder on the ALVA BC6 System drive.  
 

7.1 Starting Notes 
  
To start the Notes application: 
 
 Press Space + b1345 to start Notes. Alternatively, open the Local Menu to start 

Notes.  
 
In all two situations Notes will open a new file. To be able to activate Notes, you may 
have to close your screen reader.  
 

7.2  Using Notes 
 
This paragraph will describe the different options of Notes in more detail. 
 

 7.2.1 Editing text 
Use the following chord commands to edit text. 
 
Chord command Keyboard Key 
Backspace Space + b12 
Delete Space + b45 
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7.2.2 Navigating in Notes 
Please use the following commands to navigate in the text: 
 
Chord command Keyboard Key 
Previous character Space + b3 
Next character Space + b6 
Previous line Space + b1 
Next line Space + b4 
Previous word Space + b2 
Next word Space + b5 
 
The cursor routing keys can also be used to move the cursor and navigate through 
the text. 
 

 7.2.3 Defining a block 
Please follow the procedure below to define a text block: 
 
1. Place the cursor at the beginning of the defined block; 
2. Press Ctrl+J to mark the beginning of the block; 
3. Move the cursor to the end of the block;  
4. Press Ctrl+K to mark the end of the block. 
 
The defined block can be copied or cut and pasted elsewhere in the text. The 
shortcut keys commands for cut, copy and paste are, Ctrl+X, Ctrl+C and Ctrl+V. 
The commands can also be found in the Notes menu. 
 

 7.2.4 Reading in Notes  
The following commands have been defined for reading text in Notes: 
 
Command ALVA 640 Comfort Key 
Scroll left Thumb key 1 or eTouch 1 
Line up Thumb key 2 or eTouch 2 or space + b1 
Back to cursor Thumb key 3 
Line down Thumb key 4 or eTouch 4 or space + b4 
Scroll right Thumb key 5 or eTouch 3 
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7.3 The Notes Menu 
 
The Notes menu can be activated by pressing the Alt key. Click on the cursor routing 
key to activate a menu item. To exit the menu, click on the Alt key once again. 
Notes menu options can be activated with shortcut key commands. Please refer to 
paragraph 7.4 for a list of short key combinations.  
 

 7.3.1 Notes main menu 
To enter the main menu, press the Alt key. The Notes main menu consists of the 
following submenus: 
 File 
 Edit 
 Braille 
 Help 
 
Press the Alt key once again to exit the main menu. 
 

 7.3.1.1 File menu 
To enter the File menu, click on File in the main menu, using the cursor routing keys. 
The File menu contains the following options: 
 New 
 Open 
 Save 
 Save As 
 Delete 
 Exit 
 
New Note 
To create a new note, click on New in the File menu. If the current note contains 
unsaved text, Notes will ask you to save the changes. 
 
Open a Note 
To open an existing note, click on Open in the File menu, using the cursor routing 
keys. A list containing existing notes will display.. 
 
Save a Note 
To save a note, click on Save in the File menu. If the note does not have a name yet, 
you will be prompted to enter a new name. 
 
Save As 
Clicking on Save As will prompt you to name your current note. If the name already 
exists you will be asked to overwrite the existing file. Clicking on “No” will prompt you 
to enter a different file name. 
 
 
Delete a note 
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Clicking on Delete will prompt you to select the file to be deleted. You will need to 
confirm to delete the selected file by clicking on "Yes".  
 
Exit Notes 
Clicking on Exit will close Notes. If the current note has not been saved, you will be 
prompted to save the file. Clicking “Yes” will require that you enter a file name. 
Clicking “No” will close Notes without saving the file. 
 

 7.3.1.2 Edit menu 
The Edit menu contains the following options: 
 Cut 
 Copy 
 Paste 
 Find 
 Find next 
 
Cut 
By clicking “cut”, the selected block or character will be cut. The selected block or 
character may be pasted elsewhere in the text. The shortcut key command for “cut” is 
Ctrl+X.  
 
Copy 
By clicking “copy”, the selected block or character will be copied. The selected block 
or character may then be pasted elsewhere in the text. The shortcut key command 
for “copy” is Ctrl+C. 
 
Paste 
To paste a “cut” or “copied” block, click “paste”. You can also use the shortcut key 
command Ctrl+V. 
 
Find 
To find a word or phrase in a text, click on find and enter the text to be searched for. 
To start the search press Enter. 
 
Find Next 
Find Next will continue the search for the same text string entered in Find. 
 

 7.3.1.3 Braille 
If you enter text in contracted Braille, the file will be saved in contracted Braille. To 
translate the file to text format, save the file using the menu option "Contracted to 
text" under the Notes Braille menu.  
 
 

 7.3.1.4 Help 
The Help menu displays the about screen. Press Space+b15 to exit this screen. 
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7.4 Notes Shortcut Key Combinations 
 
Below you will find an overview of the most frequently used shortcut key 
combinations: 
 
Command Keyboard Key 
Previous line Space + b1 
Previous word Space + b2 
Previous character Space + b3 
Next line Space + b4 
Next word Space + b5 
Next character Space + b6 
Backspace Space + b12 
Delete Space + b45 
Escape Space + b15 
Copy Space + b14 
Mark start of block Space + b245 
Mark end of block Space + b13 
New note Ctrl + b1345 
Open note Ctrl + b135 
Save note Ctrl + b234 
Paste Ctrl + b1236 
Open / Close Notes Menu Alt 
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Appendix: Safety and regulatory notices 
This equipment has been developed and tested in order to comply with the following 
regulations: 
 
   and  for a Class B digital device, pursuant to part 15 rules. 
 
 
These limits are designed to provide reasonable protection against harmful 
interference in a residual installation. This equipment generates, uses and can 
radiate radio frequency energy and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio communications. However, 
there is no guarantee that interference will not occur in a particular installation. If this 
equipment does cause harmful interference to radio or television reception, which 
can be determined by turning the equipment off and on, the user is encouraged to try 
to correct the interference by one of the following measures: 

• Re-orient or relocate the receiving antenna. 
• Increase the separation between the equipment and receiver. 
• Connect the equipment into an outlet on a circuit different from that to which 

the receiver is connected. 
• Consult the distributor or an experienced radio/TV technician for help. 

 
Medical electrical equipment needs special precautions regarding EMC (Electro 
Magnetic Compatibility) and needs to be installed and put into service according to 
the EMC guidelines. 
WARNING: The use of accessories, transducers and cables other than those 
specified and sold by the manufacturer of the ALVA 640 Comfort as replacement 
parts for components, may result in increased emissions or decreased immunity of 
the ALVA 640 Comfort. 
 
By design the ALVA will shut down in case of an ESD 8KV test pulse. The ALVA 640 
Comfort will need to be switched on again to resume. 
 
CE Caution:  

• The input and output parts need to be connected properly;  
• The unit is for exclusive interconnection with IEC/EN 60XXX certified 

equipment outside of the user environment and IEC/EN 60601-1 certified 
equipment within the user environment. 

• This device complies with EN 60601-1-2. To minimize the interference from 
other equipment, a minimum 0.5 m distance shall be kept from other potential 
electromagnetic sources, such as a Mobile Phone. 

•  Equipment connected to the analog or digital interfaces must comply with the 
respective IEC/EN standards (e.g. IEC/EN 60950-1 for data processing 
equipment and IEC/EN 60601-1 for medical equipment). 

• Do not open the housing. 
• Only qualified service personnel should service the unit.  
• All possible configurations shall comply with the current version of the 

standard for SYSTEMS IEC/EN 60601-1-1 directive.  
• When connecting additional equipment to the signal input part or signal 

output part of the device, be aware a medical system is being configured. 
Therefore, the person who configures and interconnects the system is 
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responsible for the whole system and needs to make sure it complies with 
the current version of the requirements of the system standard IEC/EN 
60601-1-1. In case there is any doubt about the system compliance with the 
current version of the requirements of the system standard IEC/EN 60601-1-
1, consult the technical service department or your local representative. 

 
FCC: 
FCC Notice: 
This equipment has been tested and found to comply with the limits for a Class B 
digital device, pursuant to part 15 of the FCC rules. These limits are designed to 
provide reasonable protection against harmful interference in a residential 
installation. This equipment generates, uses and can radiate radio frequency energy 
and, if not installed and used in accordance with the instructions, may cause harmful 
interference to radio communications. However, there is no guarantee that 
interference will not occur in a particular installation. If this equipment does cause 
harmful interference to radio or television reception, which can be determined by 
turning the equipment off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures: 

• Reorient or relocate the receiving antenna. 
• Increase the separation between the equipment and receiver. 
• Connect the equipment into an outlet on a circuit different from that to which 

the receiver is connected. 
• Consult the dealer or an experienced radio/TV technician for help. 

 
FCC Caution: 
To assure continued compliance, follow the attached installation instructions and use 
only shielded interface cables with ferrite core connecting to computer or peripheral 
devices. Any changes or modifications not expressly approved by the party 
responsible for compliance could void the user’s authority to operate this equipment. 
 
FCC RF Radiation Exposure Statement:  
This Transmitter must not be co-located or operating in conjunction with any other 
antenna or transmitter. This equipment complies with FCC RF radiation exposure 
limits set forth for an uncontrolled environment. To maintain compliance with FCC RF 
exposure compliance requirements, avoid direct contact to the transmitting antenna 
during transmitting. Any changes or modifications (including the antennas) made to 
this device that are not expressly approved by the manufacturer may void the user’s 
authority to operate the equipment. 
 
Explanation Of Graphical Symbols:  

 

This symbol warns user that uninsulated voltage within the unit may have 
sufficient magnitude to cause electric shock. Therefore, it is dangerous to 
make any kind of contact with any part inside this unit. 

 

This symbol alerts the user that important literature concerning the operation 
and maintenance of this unit has been included. Therefore, it should be read 
carefully in order to avoid any problems. 

 Stand-by 

 Direct Current 
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Safety Logo:  
 
 

This device complies with the 
93/42/EEC, EN60601-1,EN60601-2 
of related European standards. 
 
Disposing of your old product:  
-If you see this symbol- 

Information on Disposal for other Countries outside the 
European Union. 

 
This symbol is only valid in the European Union. 
If you wish to discard this product, please contact your 
local authorities or dealer and ask for the correct 
method of disposal. 

 
Classification:  

• No protection against the ingress of water: IPX0 
• Mode of operation: Continuous Operation 
• The equipment not suitable for use in the presence of a flammable anesthetic 

mixture with air or with oxygen or nitrous oxide: Not AP or APG Category: 
 
Environmental conditions 
Environment  Operating Temperature: +0 ℃ ~  +40℃ 

Conditions Storage/Transportation 
Temperature: -20 ℃ ~  +60℃ 

 Operation Relative Humidity: 20% ~80% Non-Condensing 

 Storage/Transportation 
Relative Humidity: 10% ~95% Non-Condensing 

 Atmospheric pressure: 500~1060 hPa 

 
Warranty conditions 
Optelec warrants the ALVA 640 Comfort, effective from the date of delivery, to be 
free of any defects in material and workmanship.   
Warranty is not transferable. The ALVA 640 Comfort and BC680 has been designed 
for the individual purchaser to be used in home and office environments. Optelec 
reserves the right to repair or replace any purchased ALVA 640 Comfort and BC680 
with a similar or better product. 
In no event shall Optelec or its distributors be liable for indirect or consequential 
damages. The original user’s remedies are limited to replacement of ALVA 640 
Comfort modules. This warranty is valid only when serviced in the country of original 
purchase and with intact seals. For additional warranty claims or service during or 
after warranty period, please refer to your distributor. 
Optelec takes no responsibility for use of this device other than described in this 
manual.  
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Optelec offices worldwide  
 

 
 

Optelec U.S. Ltd 
3030 Enterprise Court, Suite C 

Vista, CA 92081 
U.S.A. 

T. +1 (800) 826-4200 
www.optelec.com 

 
Optelec Canada 

1832, Boulevard Marie-Victorin 
Longueil, QC J4G 1Y9 

Canada 
T : +1 (800) 665-3005 

www.optelec.ca  
 

Optelec Limited 
2, Millfield House, Woodshots Meadow 

Croxley Green Business Park 
Watford, WD18 8YX 

United Kingdom 
T: +44 (0)1923 23 13 13 

www.optelec.co.uk 
 

Optelec Nederland BV 
Breslau 4 

2993 LT Barendrecht 
The Netherlands 

T: +31 (0)88 6783 555 
www.optelec.nl 

 
Optelec NV 

Baron Ruzettelaan 29 
B-8310 Bruges 

Belgium 
T: +32 (0)50 35 7555 

www.optelec.be 
 

Optelec GmbH 
Fritzlarer Strasse 25 
34613 Schwalmstadt 

Germany 
T: +49 (0)6691 96170 

www.optelec.de 
       

 
Optelec Corporate Headquarters: Breslau 4 - 2993 LT Barendrecht – The 

Netherlands – T: +31 (0)88 678 3444 – www.optelec.com 

http://www.optelec.com/
http://www.optelec.ca/
http://www.optelec.co.uk/
http://www.optelec.nl/
http://www.optelec.be/
http://www.optelec.de/
http://www.optelec.com/


Optelec  ALVA 640 Comfort 

Deutsch  Seite 30  


	1.  Introduction
	1.1. About this manual
	1.2. ALVA 640 Comfort package contents

	2. Getting to know your ALVA 640 Comfort
	2.1. The ALVA 640 Comfort lay-out
	2.1.1. Surface and front panel lay-out
	2.1.2. Right side lay-out
	2.1.3. Left side lay-out
	2.1.4. Front panel keys, eTouch navigation buttons and cursor routing keys
	2.1.5. ALVA 640 Comfort Braille keyboard lay-out


	3.  Installation
	3.1. Setting up the ALVA 640 Comfort
	3.1.1. Setting up the USB connection

	3.2. Installing ALVA 640 Comfort screen reader drivers
	3.3. Bluetooth® connection

	4. The ALVA 640 Comfort menu
	4.1. Local Menu
	4.1.1. Activating the Local Menu
	4.1.2. Changing settings in the Local Menu

	4.2. The Bluetooth® Menu

	5.  Power Sources
	5.1. USB power
	5.2. Internal battery

	6. Using the Braille keyboard
	6.1. Chord commands
	6.2    Prefix chord commands
	6.3    Contracted Braille on/off
	6.4.     Special characters on/off

	7. Notes
	7.1 Starting Notes
	7.2  Using Notes
	7.2.1 Editing text
	7.2.2 Navigating in Notes
	7.2.3 Defining a block
	7.2.4 Reading in Notes

	7.3 The Notes Menu
	7.3.1 Notes main menu
	7.3.1.1 File menu
	7.3.1.2 Edit menu
	7.3.1.3 Braille
	7.3.1.4 Help

	7.4 Notes Shortcut Key Combinations

	Appendix: Safety and regulatory notices
	Optelec offices worldwide

